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EagleVision-NT software is a configuration and diagnostic tool for Eagle
Quantum™ or Eagle 2000™ systems. The software provides convenient
and accurate system configuration, ensures that all vital system status
information is quickly and easily accessible to the operator, and pro-
vides diagnostic and troubleshooting tools.

There are no cumbersome keyboard commands for the operator to
learn. The entire interface is graphic in nature. Onscreen point and click
icons allow convenient navigation through the application with easy
access to the various features.

The EagleVision-NT database contains all the information needed to
allow easy and accurate configuration of Det-Tronics products. All per-
tinent information for the device including user selectable options is dis-
played on the point configuration screen, where changes can be made
as desired.

Point display screens for each node on the network provide detailed sta-
tus information. The eight most recent alarm events are recorded, and a
record of the zero and span calibration values is maintained to allow
the operator to track sensor sensitivity trends.

EagleVision-NT offers password protection to keep unauthorized per-
sonnel from modifying system configuration.

Two versions of EagleVision-NT are available — standard EagleVision-
NT and EagleVision-NT for Wonderware.

Standard EagleVision-NT will run under Windows 95 or Windows NT
and is designed as a stand alone application for configuration, diag-
nostics and event recording.

EagleVision-NT for Wonderware is designed to run with the
Wonderware® Intouch HMI (human-machine interface) program version
6.0 or higher, and requires the Windows NT operating system.
EagleVision-NT for Wonderware provides two additional features —
real time data exchange to and from Intouch, and a tagname export
function.

95-8479

1.1PRODUCT OVERVIEW



• User friendly point and click navigation, with no special keyboard
commands to learn. 

• Menu driven configuration ensures easy installation or modifica-
tion.

• Configuration additions or changes can be made at any time with-
out interrupting system operation.

• Alarm and calibration data available online.
• Automatic diagnostics ensures reliable system operation.
• Current device status and alarm logs can be viewed in detail.
• Eagle Quantum logic generation.

EagleVision-NT can operate on most Intel® based computers (Pentium®

processor recommended), running Windows 95® or preferably
Windows NT® 4.0 or later. The software can support multiple Eagle
loops (up to a maximum of 16) on computers equipped with serial port
expansion hardware.

EagleVision-NT is designed to support the Eagle Quantum Fire and Gas
Detection/Releasing System and the Eagle 2000 Hazard Event
Monitoring System.

EAGLE QUANTUM™ SYSTEM

Eagle Quantum combines a flame detection/extinguishing agent
release system with a hazardous gas monitoring system, integrated on
a fault tolerant digital communication network. The system continuously
monitors analog process signals such as gas concentrations as well as
flame detectors and contact closure type devices such as manual fire
alarm call boxes and heat detectors. The fire related sensor inputs can
then be used by the control unit for executing the fire suppression logic,
controlling the extinguishing agent release, signaling and annunciating
output actuation.

The Eagle Quantum system consists of three basic components:

1. Local Control Unit (LCU) functions as the “heart” of the system. It
contains the fire logic and provides operator interface controls.
External host devices that are used for configuration and monitor-
ing of the system interface through the LCU.

2. Local Input/Output Unit (LIOU) is part of the fire detection portion
of the system and performs functions such as fire suppression agent
release and notification. The LIOU is controlled and supervised by
the LCU, and must be located within 25 feet of the LCU.

1.2 PRODUCT OVERVIEW
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3. Local Operating Network/Signaling Line Circuit (LON®/SLC)
allows intelligent input and output devices to communicate with the
LCU. It consists of a fault tolerant, two wire, digital communication
network that is arranged in a loop that starts and ends at the LCU.

Field devices can consist of a combination of Digital
Communication Units (DCUs), Initiating Device Circuits (IDCs),
Ultraviolet (UV) and Ultraviolet/Infrared (UV/IR) flame detectors,
Agent Release Modules (ARMs), Sounders (also referred to as
Signal Audible Modules or SAMs), and Network Extenders.

EAGLE 2000™ SYSTEM

Eagle 2000 is a hazard event monitoring system that is used primarily
for monitoring relatively large numbers of combustible and/or toxic gas
detectors. The Eagle 2000 network can span up to 32,000 feet
(10,000 meters) with up to 250 intelligent field devices.
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EagleVision-NT can operate on most Intel® based computers running
Microsoft Windows 95/NT. Although the software can be used with
Windows 95, Windows NT 4.0 or later is the preferred operating pro-
gram. Windows NT is required for use with Wonderware.

A minimum of 16 megabytes of RAM are required, however, 32 or
more megabytes are recommended for optimum performance.

The software requires a color monitor with a minimum resolution of 640
by 480.

A hard drive with at least 10 megabytes free is also required.

The system can utilize any properly installed printer.

1. Insert the EagleVision-NT Disk 1 into the floppy drive. From the
Windows Program Manager menu bar, select File, Run and type
a:\setup.

NOTE
Installing EagleVision-NT does not affect AUTOEXEC.BAT, CON-
FIG.SYS or any other system files.

2. Follow the directions on the screen.

3. Insert Disk 2 when instructed and continue to follow the directions
on the screen.

4. When the installation is completed, double click on the Quantum
icon to start the program.

TAGNAME EXPORT FOR WONDERWARE’S INTOUCH PROGRAM

EagleVision-NT exchanges real time data by directly monitoring and
updating changes to Intouch tagname values. For this to work properly,
EagleVision-NT must know the exact name of all shared tagnames.

EagleVision-NT uses DLLs (Dynamically Linked Libraries) to exchange
real time data with Intouch. The DLLs are a part of the EagleVision-NT
for Wonderware program and must be loaded and running for the pro-
gram to operate. When EagleVision-NT for Wonderware starts up, it
checks to see if Intouch has loaded the DLLs in memory. If it has, the DLLs
will already be running and a connection will be made. If Intouch is not
running, EagleVision-NT will automatically load the DLLs from the hard
disk. If EagleVision-NT for Wonderware is running without Intouch (for
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example, to export tagnames) a search path to the DLLs must be pro-
vided to enable EagleVision-NT to find them.

PROVIDING A SEARCH PATH TO INTOUCH DLLS

1. Select “Settings” from the “Start” Menu.
2. Select “Control Panel.”
3. Double click on the “System” icon.
4. Select the “Environment” tab. See Figure II-1.

5. Select “Path.”
6. Add the Intouch directory name to the existing string. The default

Intouch directory is ;C:\Intouch.32. If Intouch is installed under a
different directory name, enter this name instead.

7. Press the “Set” button to enable the new settings.

2.2 INSTALLING EAGLEVISION-NT

FIGURE II-1

System Properties
Screen

Intouch Directory Name



Before building the configuration database, the operator must know
exactly what hardware is used in the system.

System type — Eagle 2000 or Eagle Quantum?
How many LONs are being used?
How many and what type of field devices?

Input devices:
Flame detectors — UV, UV/IR
Gas Detectors — DCU with combustible, H2S, PointWatch, etc.
IDCs

Output devices:
SAMs
ARMs

Power supply monitors
Gateways 

Main gateway (required)
Auxiliary gateways (up to 3)

Logic Controllers
Power supplies
LIOU

Release boards
Sounder boards
Relay boards

After determining the type and number of field devices, each device
must be assigned an address.

• Main gateway must be address 1.
• Addresses 2 to 4 are reserved for auxiliary gateways.
• Logic controllers occupy two adjacent addresses. They are assigned

an odd address and automatically assume the following even
address. For convenience it is recommended to work up from
address 5. 

• The remaining addresses are available for field devices.

NOTE
The gateway relays are programmed to monitor a “block” of
addresses. Take this into account when selecting addresses for
field devices.

1. To start a new database, select “New” under the “File” menu.

2. To save the project, select “Save” under the “File” menu. If the file
has not been named, select “Save As,” name the file, and save.
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To configure each system device:

1. From the Point Configuration screen, select an address and click on
the “Modify Point” button. The “Point not Defined” screen will be dis-
played. Click on the “Define” button.

2. Select the type of device, and click on OK.

3. Select the desired device parameters. Refer to the appropriate
device configuration section of this manual for complete details.

4. Repeat for each device in the system.

5. Save the project.

1. To establish communication with the gateway, click on “Config”
under the “File” menu. The Port Configuration screen will be dis-
played. (Refer to “Section IV — Establishing Communications” for
complete details.)

2. To download the configuration data to the devices, click on
“Download All” or click on “Download One” starting with the low-
est address number and working up. Watch the screen for errors.
Errors may be generated if a configured device is not present or the
wrong device type is selected.

NOTE
Logic controllers must be placed in Reset/Program mode while
downloading data.

NOTE
The gateway retains a copy of the configuration data, which can
later be used for auto configuration.

3. Check to be sure that all devices are communicating.

4. Select the gateway, then click on “Write EEPROM” to write the data
to the gateway EEPROM. Select the logic controller and click on
“Write EEPROM” to write the data to the logic controller EEPROM.

When designing a system, it is important to realize that increasing the
number of nodes on the LON results in a corresponding increase in the
amount of time required for a status change message from a detection
node to be processed by the gateway. The gateway can handle an
average of 50 status messages per second. This means that if a LON
consists of 50 devices, all devices could be programmed for a status
update rate of 1 second (updates rates are adjustable from 1 to 10 sec-
onds). For a LON with 100 devices, they can all report at a two second
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interval. When 250 LON devices are used, the average status update
time can be set for 5 seconds. Note that all units do not need to be pro-
grammed for the same update rate. Higher priority devices can be set
for a shorter time, while lower priority units can be set for a longer time.
The important factor is the average time for the entire LON — this must
not exceed 50 messages per second.

The color of the tab in the lower left hand corner of the Point
Configuration screen indicates the current system status.

None = Normal operation (No devices in Alarm or Fault)
Red = Alarm
Yellow = Fault.

From the Point Configuration screen, click on the Overview button to dis-
play the System Overview screen. See Figure III-1. This screen provides
an overview of the entire system. Each configured node is represented
by a square on the loop, and is identified by its address number. The
color of the square indicates the status condition. (This screen is also
used for diagnostics purposes. Refer to Section IX - LON Troubleshooting
for details.)

Black = Normal operation
Red = Alarm
Yellow = Fault condition.

NOTE
An alarm condition will override a fault condition.

95-8479

3.3CONFIGURATION AND SYSTEM MONITORING OVERVIEW

SYSTEM MONITORING

FIGURE III-1

System Overview
Screen



To further identify a device on the loop, place the cursor on the square,
but do not click. The description/identifier that was entered for this
device at the time of configuration will be displayed below the square.
For complete status information for this node, double click on the square
to open the point display screen for the device. (Refer to Section VII or
VIII for information regarding Point Display screens.)

EVENT LOG
(FOR EAGLEVISION-NT WITHOUT WONDERWARE)

A complete listing of all system status events is displayed on a window
that runs the full width of the screen at its bottom. (The event log window
can be moved to any position on the screen by clicking on the title bar
and dragging it to the desired location.) To open the Event Log, click on
Event Log under the View menu. See Figure III-2.

The event log displays system events as they occur. Each new event that
occurs will appear at the bottom of the window and any previous events
will move up. Information displayed includes LON number, device
address and type, date and time, description of event, and event status
(on or off).

IMPORTANT
The event log window must be open for this feature to function.
Events that occur prior to opening the event window will not be
displayed. 

If screen space is at a premium, click on Minimize under the Window
menu. The events log window is reduced to a button labeled “Events”
in the lower left hand corner of the screen. All events occurring while
the event log is “minimized” will be recorded. To view the events log,
double click on the button. 

Clicking on Maximize under the View menu causes the event log to fill
the entire screen.

3.4 CONFIGURATION AND SYSTEM MONITORING OVERVIEW
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Events are color coded according to the Trigger configuration for the
device type. (Refer to “Device Trigger Configuration” in the
Configuration section of this manual for information regarding triggers.) 

Red = alarm
Yellow = fault
Blue = return to normal
Black = other events.

Events are also logged to the computer’s hard drive. A separate file is
kept for each day. At midnight each day, the existing file is closed and
a new file is automatically added. All events present on the Event log
are recorded on the hard drive. Daily event files are identified by year,
month and day. These files are not automatically deleted from the hard
drive. Periodically, the operator must delete any unwanted files.

To obtain a permanent record of the event log, click on Print under the
File menu. All data currently listed in the event log window (all events
occurring since the last time that the log was cleared) will be printed. 
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The Operator Interface Station (OIS) must be configured to communi-
cate with the gateway. Select Config under the File menu to display the
Communication Port Configuration screen. See Figure IV–1. This screen
is used to create and define LON networks as well as serial communi-
cation connections.

Type a tag name for the LON in the LON Name box. This name will
appear on the tab in the lower left corner of the screen and is also used
as a prefix for the Wonderware tagnames. It should be kept as short as
practical.

Select the type of system (Eagle 2000 or Quantum) in the box labeled
Gateway.

Enter the desired values in the Modbus Address, Com Port, Baud Rate,
Stop Bits, Parity and Data Bits fields. (Refer to the appropriate hardware
instruction manual for complete switch setting information — form num-
ber 95-8470 for Eagle Quantum or 95-8424 for Eagle 2000.) When
Gateway port 2 is used (port 0 for Eagle 2000) the values are fixed at
9600 baud, even parity and one stop bit. When Gateway port 1 is
used, the values selected in these fields must match the Gateway DIP
switch settings for baud rate, stop bits, parity and data bits.

Modbus Address must match the value set on the gateway Modbus
address DIP switches, S7. When gateway port 1 is used, the address is
set using the gateway’s DIP switches. When port 2 is used (port 0 for
Eagle 2000), the address is set using software from the Gateway
Configuration screen. The default address is 1.
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Com Port defines which PC serial port is connected to the gateway.
Clicking on the button next to Com Port initiates a routine in which the
software systematically tries all valid combinations of baud rate, data
bits, and parity. If a connection is successfully established, the software
will fill in the appropriate values.

Writes Count tracks the number of outgoing messages to the gateway. 

Reads Count tracks the number of responses. These two numbers
should track each other, however, a small disparity does not necessari-
ly indicate a problem. 

Average Poll Time is the amount of time for the gateway to respond
to the message.

This data indicates communication errors. These values can be helpful
in diagnosing communication problems.

CRC (Cyclical Redundancy Check) is an error checking method. This
field is incremented when the calculated CRC value is different than the
transmitted value. This error is typically caused by incorrect serial com-
munication settings.

Data. This field tracks the number of response messages that have the
wrong data size.

Com. This field tracks the number of serial communication errors report-
ed by the operating system.

Command. This field tracks the number of Modbus error responses.
This can occur if the gateway is not configured properly. Check the set-
ting of the Main/Aux gateway DIP switch.

Timeouts. This number is incremented each time the gateway does not
respond to the message from the OIS.

When correct communication is established, the read and write counts
should match, with zeros displayed in the Error boxes.

Close closes this window.
Add creates a new LON.
Cancel cancels the entry.
Reset Counts resets the counters.
Delete deletes the LON.

4.2 ESTABLISHING COMMUNICATIONS
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Double click on the Quantum icon to start EagleVision-NT. The Point
Configuration screen is displayed. See Figure V–1.

The first step in system configuration is selection of device triggers, as
described below.

NOTE
The default trigger lists will ensure correct operation in the major-
ity of applications, and no modifications to the lists are required.
If it is determined that changes to the default trigger lists are
required or additional trigger lists need to be added, follow the
procedure described below.

Each Eagle field device has discrete pieces of status information. Device
triggers are the means through which the operator tells the system how
to treat each of these pieces of information — which ones constitute an
alarm, which constitute a fault, and which are handled simply as system
events.

Device triggers are used by one of EagleVision-NT’s diagnostic features
called the “Overview” screen. The Overview screen shows a schematic
representation of the loop and its field devices. It then graphically dis-
plays the status of each point — whether it is normal, in alarm, or fault.

The conditions that will trigger an alarm or fault are determined during
system configuration. A default trigger “list” has been provided for each
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device type. The default list can be accepted as is, it can be modified,
or additional lists can be created as needed. This feature allows similar
device types to respond differently to various input conditions. For exam-
ple, one IDC can be programmed to trigger a fault condition in
response to an active input condition, while a different IDC can be pro-
grammed to generate an alarm.

1. Under the Edit menu select Triggers.

2. Select the type of device from the Select Triggers Form.

3. To view or modify the selected trigger list, click on the Modify but-
ton. To create a new trigger list, click on the New button. The Edit
Triggers screen will be displayed. See Figure V–2.

4. If a new list is created, enter the new trigger name in the space pro-
vided at the top of the screen.

5. Select the device type from the pull down menu.

6. To make modifications to the list, simply click and drag the item to
the appropriate column. Right column = alarms. Middle column =
faults. Left column = other.

7. If EagleVision-NT is being used with Wonderware, the operator has
the option to enable the alarm and event fields in the tagname def-
inition and also assign priorities for the tagnames. Selecting a tag-

5.2 EAGLE QUANTUM SYSTEM CONFIGURATION
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name and clicking on the Events or Alarm button enables or disables
the event or alarm log control bit in the Wonderware db.CSV export
file. The Event or Alarm priority value will also be exported.

To select tagnames, hold the Shift key and click on the tagnames.
Then click on either the Events or Alarm button. Tagnames will be
color coded on the Edit Triggers screen as follows:

Alarms = Red, Events = Blue, Off = Black.

Enter the desired priority level (0 to 999) in the “Event” and “Alarm”
boxes located in the upper right hand corner of the screen.

8. Click on Close to return to the Select Triggers Form screen.

9. Click on Close to return to the Point Configuration screen.

PRINTING TRIGGER DATA

To obtain a permanent record of trigger information for the system, from
the Select Triggers screen select Print under the File menu. EagleVision-
NT will print a list of trigger data for all devices in the system. This
includes both factory default triggers and custom triggers. Printed infor-
mation includes the type and name for each trigger as well as a com-
plete listing of all events configured under the categories of alarm, trou-
ble and other.

GATEWAY CONFIGURATION

Addresses 1 through 4 are reserved for gateways only. Address num-
ber 1 should be used for the main gateway and 2 to 4 for auxiliary
gateways (if used).

1. Highlight line 1 on the Point Configuration screen. Click on the
Modify Point button.

2. Click on the Define button. Select the gateway type, then click on
OK. The Gateway Configuration screen will be displayed. See
Figure V–3.
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3. Type a tag name for the point in the space provided.

4. Assign a trigger for the point.

5. Select gateway type and fill in the appropriate port configuration
data. These settings are determined in conjunction with the gateway
DIP switch settings. (Refer to the hardware manual for switch setting
information.)

Port 1. Serial Port 1 on the Eagle Quantum gateway is configured
for Allen Bradley DF1 or Modbus RTU protocol using a DIP switch
on the gateway. The drop address is also set using a DIP switch on
the gateway. The interface uses Allen Bradley PLC5 logical address-
ing.

Allen Bradley DF1 Mode

EagleVision-NT supports Binary and ASCII addressing modes. It
does not support multiple message responses — no more than 120
words with a single request. EagleVision-NT supports full duplex
mode as well as the functions listed in Table V-1.

5.4 EAGLE QUANTUM SYSTEM CONFIGURATION
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The “Word Range Write” function will not call control word func-
tions. The “Read Modify Write” or “Typed Write” functions must be
used for control words. N:20 and 21 are the default file numbers,
and can be changed by entering the desired file number in the AB
File No. field under Port 1 Config on the Gateway Configuration
screen. The lowest file number (N:20) can be changed in the gate-
way configuration while the second file number is always one high-
er.

Refer to Table V-2 for the Allen Bradley memory map.

Modbus RTU Mode

When Modbus mode is used, the gateway is the slave device.

Port 2. Port 2 of the Gateway can be configured for either Modbus
master or slave operation. 

As a Modbus RTU master, it actively “feeds” a copy of its datatables
to a slave PLC. When set for the master mode, enter the PLC address
in the Modbus Address field under Port 2 Config. 

When set for the slave mode, enter the gateway address in the
Modbus Address field. (The address in the Modbus Address field
should be the address of the slave device.)

The Master Data Offset specifies where in the slave PLC’s register
memory (40,000 registers) the data from the Eagle system will
begin.
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AB Function
DefinitionNumber

0 Word Range Write
1 Word Range Read

26H Read Modify Write
67H Typed Write
68H Typed Read

TABLE V-1

Functions Supported
by EagleVision-NT

File Number Element Memory Block Access

N:21 0 to 499 A Configuration Read / Write (Non-Volatile)

N:20 500 to 749 B Control Words Read / Write (Gateway will clear the bit)

N/A C-1 Extended Gateway Status Read Only

N:20 0 to 249 C-2 Status Words Read Only

N:20 250 to 499 D Process Variable Read Only

N:20 750 to 874 E-1 Transfer Buffer from Gateway Read Only

N:20 875 to 999 E-2 Transfer Buffer to Gateway Read / Write

N:21 500 to 515 F Last Direction Data Read Only

TABLE V-2

Allen Bradley
Memory Map



6. Enter a starting and an ending address for each of the four gateway
relays. These numbers identify a specific “block” of addresses that
will be monitored by each gateway relay. Then check the appropri-
ate boxes to select the event(s) that will actuate each of the relays.
The fault relay will be actuated upon detection of a LON fault (LON
open or shorted) or an internal gateway fault (self-diagnostic test
failure).

7. Check the appropriate “Energized” button if a normally energized
relay coil is desired. The coil will become de-energized when the
relay status becomes active.

8. Checking the Automatic Device Configuration box will cause all
configuration information to remain in effect after the replacement of
an electronic module or an entire field device. This will allow field
device replacement or repair without the need for operator initiated
re-configuration, however, all DIP switches on the replacement
device must be set exactly the same as the original. (This feature is
available for Eagle Quantum systems only.)

9. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

LOGIC CONTROLLER BASE CONFIGURATION

1. Highlight line 5 on the Point Configuration screen. Click on the
Modify Point button. Click on the Define button. Select Logic
Controller, then click on OK. The Logic Controller Configuration
screen will be displayed. See Figure V–4.
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FIGURE V-4

Logic Controller
Configuration Screen



The Logic Controller occupies two adjacent addresses. When con-
figuring a Logic Controller, it must be assigned an odd address. It
will then automatically use the following even address. A Logic
Controller can be assigned any address from 5 to 249, however,
address number 5 is recommended. (If additional Logic Controllers
are used, they should be assigned to Addresses 7, 9, etc.)

2. Type a tag name for the point in the space provided.

3. Assign a trigger for the point.

4. The Logic Controller communicates over the network with input
devices such as flame detectors, DCUs, and IDCs, and output
devices such as SAMs and ARMs, as well as all devices in the LIOU.
The remainder of the Logic Controller configuration will be covered
in connection with the configuration of those devices later in this
manual.

5. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

DCU CONFIGURATION

To configure a DCU with combustible gas sensor, O2 sensor, or
PointWatch:

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the appropriate button for the type of device being config-
ured, then click on OK. The DCU Configuration screen will be dis-
played. See Figure V–5.
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4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Click on the Defaults button to display the default values for cali-
bration gas, high and low alarm setpoint, and update rate. If other
values are desired, enter them in the appropriate boxes.

When a K Factor is Used

If the sensor is calibrated using a gas type that is different than the
gas being detected, a calibration “K factor” must be used. (Refer to
Det-Tronics Technical Note No. GTN01 for complete information
regarding the use of K factors.)

If a K factor is used for sensor calibration, a similar adjustment
should be made when entering the calibration gas value at the OIS.
Use the following formula to determine the correct value to be
entered in the box labeled “Now” under Cal. Range. This will
ensure the most accurate gas level reading at the OIS.

C  x  K  =  S

C  = Concentration of calibration gas in % LFL
K  = K factor for the gas to be monitored (from Table 1 in GTN01)
S  = Corrected calibration output level

(Enter this value in the box labeled “Now” under Cal. Range).
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FIGURE V-5

DCU Configuration Screen



7. Enter the Destination Address(s). The Destination Address is the
address of the Logic Controller that will receive messages from this
DCU. If the DCU will report to more than one Logic Controller, an
address for each Logic Controller (up to a maximum of four) must be
entered.

Since Logic Controllers occupy two addresses, they are able to
receive messages at either address. (Do not program a single point
to report to both addresses.)  To maximize system speed and per-
formance, it is recommended to alternate odd and even addresses
during system configuration — i.e. half of the field devices report to
the odd address and the other half report to the even address. A
convenient way to do this is to have odd numbered field devices
report to the Logic Controller at its odd address and even numbered
devices at the even address. (Failure to alternate odd and even des-
tination addresses will not compromise system communication.)

8. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

To configure a Universal DCU:

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the DCU Universal button, then click on OK. The DCU
Universal Configuration screen will be displayed. See Figure V–6.
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DCU Universal
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4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Define engineering units and enter the name in the box provided.

7. Enter the full scale value in the “High” box under Engineering
Range. The Low value must be 0.

8. Under Calibration Type, select either manual or automatic for the
type of calibration that will be used. (Refer to the hardware manual
for complete calibration information.)

9. Click on the Defaults button to display the default values for cali-
bration gas, high and low alarm setpoint, and update rate. If other
values are desired, enter them in the appropriate boxes. (Refer to
“When a K Factor is Used” above if a K factor is being used for sen-
sor calibration.)

10.Enter the Destination Address(s). (Refer to step 7 above for instruc-
tions regarding selection of destination addresses.)

11.Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

IDC CONFIGURATION

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the IDC button, then click on OK. The IDC Configuration
screen will be displayed. See Figure V–7.
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4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Select an input mode for each of the two channels.

7. Click on the Defaults button to set the update rate default value. If a
different update rate value is desired, enter the value in the box
labeled “Milli-Secs” under Update Rate.

8. Enter the Destination Address(s). (Refer to step 7 under “DCU
Configuration” for instructions regarding selection of destination
addresses.)

9. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

UV DETECTOR CONFIGURATION

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the UV Detector button, then click on OK. The UV
Configuration screen will be displayed. See Figure V–8.
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IDC Configuration Screen



4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Select sensitivity level, signal processing mode, latching/non-latch-
ing, time delay, automatic oi, and arc rejection level (if arc rejection
is selected). (Refer to the hardware instruction manual for a com-
plete description of the detector’s features and options.)

7. Click on the Defaults button to set the update rate default value. If a
different update rate value is desired, enter the value in the box
labeled “Milli-Secs” under Update Rate.

8. Enter the Destination Address(s). (Refer to step 7 under “DCU
Configuration” for instructions regarding selection of destination
addresses.)

9. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

UV/IR DETECTOR CONFIGURATION

Refer to the “Specifications” section of the Eagle Quantum hardware
instruction manual (form number 95-8470) for suggested settings for
detecting various fires at specified distances using the Eagle Quantum
UV/IR detector. These settings are recommended as a “starting point,”
with the final settings determined and verified through field tests.
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FIGURE V-8

UV Configuration Screen



1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.

3. Click on the UV/IR Detector button, then click on OK. The UV/IR
Configuration screen will be displayed. See Figure V–9.

4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Configure the point by selecting:

Sensitivity level – UV and IR selected separately
Signal processing mode – UV only
Arc rejection level – If arc rejection is selected 
Latching/non-latching – With “latching” selected, fire alarm sig-

nal is present until cleared by a reset
command from the OIS.

Automatic Oi – Selecting “manual” disables the auto-
matic Oi test.

Oi sensitivity – IR only
Time delay – 0 to 7 seconds
Oi test frequency – IR only (UV fixed at once per minute)
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UV/IR Configuration Screen



7. Enter the desired update rate value in the box labeled “Now” under
Update Rate.

8. Enter the Destination Address(s). (Refer to step 7 under “DCU
Configuration” for instructions regarding selection of destination
addresses.)

9. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

AGENT RELEASE MODULE (ARM) CONFIGURATION

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the ARM button, then click on OK. The ARM Configuration
screen will be displayed. See Figure V–10.

4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Select the desired release mode. If “Timed” is selected, the “Release
Time” field will be activated.
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FIGURE V-10

ARM Configuration Screen



7. Click on the Defaults button to set the Update Rate and Release Time
(if selected) default values. If a different Update Rate or Release Time
value is desired, enter the value in the appropriate box.

8. Enter the Destination Address. (Refer to step 7 under “DCU
Configuration” for instructions regarding selection of destination
addresses.)

9. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

SIGNAL AUDIBLE MODULE (SAM) CONFIGURATION

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the SAM button, then click on OK. The SAM Configuration
screen will be displayed. See Figure V–11.

4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. If latching output is desired, check the Latch Enable box.
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SAM Configuration Screen



7. Click on the Defaults button to set the update rate default value. If a
different update rate value is desired, enter the value in the box
labeled “Milli-Secs.”

8. Enter the Destination Address. (Refer to step 7 under “DCU
Configuration” for instructions regarding selection of destination
addresses.)

9. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

POWER SUPPLY MONITOR CONFIGURATION

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the Power Supply button, then click on OK. The Power
Monitor Configuration screen will be displayed. See Figure V–12.

4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Select the power supply input voltage.
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FIGURE V-12

Power Monitor
Configuration Screen



7. Click on the Defaults button to set the update rate default value. If a
different update rate value is desired, enter the value in the box
labeled “Now” under Update Rate.

8. Enter the Destination Address(s). (Refer to step 7 under “DCU
Configuration” for instructions regarding selection of destination
addresses.)

9. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

1. Highlight the Logic Controller address on the Point Configuration
screen. Click on the Modify Point button.

2. The Logic Controller Configuration screen will be displayed. See
Figure V–4.

Each Logic Controller can support up to eight I/O modules of any one
type, up to a maximum of 24 modules. If the system uses more than 24
modules or if more than eight of the same device type are needed, addi-
tional Logic Controllers are required. Each module is assigned one of
the 24 positions on the Logic Controller Configuration screen. While the
modules will function normally in any position on the Logic Controller
Configuration screen, for the sake of convenience, it is recommended
that similar devices be grouped together in numerical order.

MODULE TYPE AND ADDRESS

1. Highlight position number 1 on the Logic Controller Configuration
screen.

2. Click on the Type button.

3. Select the type of device under Card Type.

4. Enter the address for the selected module. This number must match
the DIP switch setting on the module.

5. Click on OK.

6. Repeat for each module in the LIOU.
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Agent Release Module Configuration

1. Highlight the first Agent Release module.

2. Click on the Edit button. The Agent Release Configuration screen is
displayed. See Figure V–13.

3. Select the release mode for the release output.

4. Check the appropriate box if the silence function is desired for the
three signaling outputs.

5. Click on OK to return to the Logic Controller Configuration screen.

6. Repeat for each Agent Release module in the LIOU.

Sounder Module Configuration

1. Highlight the first Sounder module.

2. Click on the Edit button. The Sounder Card Configuration screen is
displayed. See Figure V–14.
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FIGURE V-13

Agent Release
Configuration Screen 



3. Select the wiring style that is being used.

4. Check the appropriate box if the silence function is desired for the
four outputs. (This allows the LCU Silence button to silence the
device.)

5. Click on OK to return to the Logic Controller Configuration screen.

6. Repeat for each Sounder module in the LIOU.

LCU Power Supply Configuration

1. Highlight the first power supply.

2. Click on the Edit button. The Power Supply Configuration screen is
displayed. See Figure V–15.
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FIGURE V-14

Sounder Card
Configuration Screen 

FIGURE V-15

LCU Power Supply
Configuration Screen 



3. Click on the appropriate button for the number of power supplies
being used.

4. Click on OK to return to the Logic Controller Configuration screen.

5. Repeat for each power supply in the LIOU.

The Logic Controller must be configured to look for messages from spe-
cific addresses on the network and to ignore the remaining addresses.
All devices reporting to the logic controller must be included.

1. Click on the Network Setup button. The Network Variables screen is
displayed. See Figure V–16.

2. The points that can communicate with the Logic Controller (IDCs, UV
detectors, SAMs, ARMs, other Logic Controllers) are listed in red,
the others in black. Highlight the first red point. To enable the point,
click on the appropriate Input or Output button. To disable a point,
click on Clear. If a regular message is not received from an enabled
address, the NV Communicating trouble bit will be set.

Depending upon the type of device and its function within the sys-
tem, this procedure can involve input, output or both. The software
will automatically select the appropriate function(s).
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CONFIGURATION

FIGURE V-16

Network Variables Screen



3. Click on Accept. Click on Close to exit and return to the Point
Configuration screen.

After the configuration data is entered and saved in the EagleVision-NT
database, it must be downloaded to the gateway. Refer to the Point
Configuration screen, Figure V–1.

DOWNLOAD ALL

When all the point configuration data has been entered, select
“Download All” to sequentially download the point configuration data
from the EagleVision-NT database to the gateway. Status messages
appear during the downloading process. The gateway will then transfer
the configuration data to the individual network devices.

For the gateway to respond to additions/modifications to the configu-
ration database, the configuration data must be downloaded.

NOTE
Logic controllers must be placed in Reset/Program mode while
downloading data.

UPLOAD ALL

Point configuration data can be uploaded from an existing gateway that
has previously been configured.  

Select “Upload All” to upload the point configuration data from the
gateway to replace the data currently in the EagleVision-NT database.
Status messages appear during the upload process.  

CAUTION
“Upload all” will overwrite the current data files in the
EagleVision-NT database.

DOWNLOAD ONE

Select “Download One” to download the configuration data for the
selected point to the gateway. Status messages appear during the down-
loading process. The gateway will then transfer the configuration data
to the individual network device.

UPLOAD ONE

Select “Upload One” to upload the selected point configuration from the
gateway. Status messages appear during the upload process.
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DOWNLOAD RTC

Select “Download RTC” to download the Real Time Clock (RTC) value
from the computer to the selected gateway. This synchronizes the gate-
way clock to the OIS clock.

UPLOAD RTC

Select “Upload RTC” to upload the Real Time Clock (RTC) value from the
selected gateway. This allows the operator to view the gateway
date/time clock values without affecting the computer’s clock.

WRITE EEPROM
(ELECTRONICALLY ERASABLE PROGRAMMABLE READ ONLY
MEMORY)

After downloading the configuration data, highlight the appropriate
Gateway or Logic Controller address and click on Write EEPROM to
write the data to non-volatile memory. This ensures that the data will not
be lost in the event of a power loss.

NOTE
Logic controllers must be placed in Reset/Program mode while
downloading data.

To obtain a permanent record of system configuration data, from the
Point Configuration screen select Print under the File menu. EagleVision-
NT will print a list of configuration data for each point in the system.
Note that while the data contained in the printout exactly matches the
data on the point configuration screen for the device, the two formats
will be different. Printed information includes the following.

For gateways, printed data includes device type and trigger, starting
and ending addresses of monitored nodes for each gateway relay,
Modbus address, master data offset and AB file number. The event trig-
gers that can be selected for activation of each of the gateway relays
are represented by the numbers 1 to 16 (these numbers correspond to
the gateway status bits). An “X” next to a number indicates that the sta-
tus condition has been selected. Refer to the Gateway Configuration
screen (Figure V-3) for identification of the status bits.

For logic controllers, printed data includes device type and trigger as
well as type and address of LIOU devices with configuration data
unique to each device.

For LON devices, printed data includes device type, trigger, update
rate, destination address, as well as any other configuration data
applicable to the device type.
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DELETE POINT

To delete a configured point, select the point to be deleted on the Point
Configuration screen, then click on the “Delete Point” button. A warning
box will ask if you want to delete the selected point.

DISPLAY POINT

Click on the “Display Point” button to view the current status of the
selected point. Refer to “Section VII - Eagle Quantum Point Displays”
and “Section VIII - Eagle 2000 Point Displays” for complete information.

OVERVIEW

Click on this button to display the System Diagnostic screen. This screen
provides an overview of the entire system, and allows the operator to
access the LON diagnostic screen and other troubleshooting tools.

ACTIVE EVENTS

Clicking on this button displays a list of system events. The event display
lists any “true” conditions in the status messages from network devices.
These events are not programmable, their message cannot be modified,
and they are unrelated to the device “triggers.”

RESET MODULE

Select “Reset Module” to initiate the equivalent of a power-up reset. This
“re-initializes” the software of the selected module, but does not affect
configuration data.

READ VOLTAGE

Select “Read Voltage” to display the supply voltage level measured at
the selected module. This feature is helpful in troubleshooting the power
distribution system.

UPLOAD VERSION

The “Upload Version” option requests the software version from the field
device.

COPY/PASTE

To quickly configure a number of identical points:

1. After configuring the first of a group of identical points, highlight this
address on the Point Configuration screen.
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2. Select “Copy” from the Edit menu.

3. Highlight the address or group of contiguous addresses where the
configuration data will be pasted, then select Paste from the Edit
menu. All of these addresses will now be configured with the iden-
tical data as the first address.

4. Sequentially select each of the new addresses, click on modify
point, assign a tag name to the point, and modify any other con-
figuration data as desired.

EagleVision-NT allows the creation of custom logic using standard gate
logic symbols. This logic is then downloaded through the Gateway to
the Logic Controller. The system supports up to 32 pages of custom
logic, each page containing up to 32 logic elements.

This software should be used only by qualified personnel. Operators
should have experience and knowledge of gate logic programming.
Contact Detector Electronics Corporation for information on upcoming
training.

PROJECT TASKS

1. Define and Configure Field Devices.
Configure the type and operating parameters for each of the
devices on the LON/SLC.

2. Local Input/Output Unit (LIOU) Configuration.  
Configure the type and operational parameters of the I/O cards that
are installed in the LIOU following the instructions discussed under
“LIOU Configuration.” 

3. Network Variable Configuration.  
Configure the logic controller to recognize the devices on the
LON/SLC that will be used by the programmable logic. This is a
part of the supervision mechanism to ensure the integrity of the sys-
tem.

4. Logic Development. 
Use the logic tools to create custom logic.

5. Logic Tests.  
Download the custom logic to the logic controller, verify its opera-
tion, then write the logic to EEPROM in the Logic Controller.

6. Logic Documentation.  
Print out the logic pages for a permanent record.
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LOGIC PAGE INFORMATION

From the Logic Controller Configuration screen (Figure V–4), click on the
Logic button. The Logic screen is displayed. See Figure V–17.

A variety of information can be entered for each logic page, including
title, date, revision etc. Select Page Information under Edit. The Page
Information screen appears. See Figure V-18. Complete the fields as
necessary for each logic page.
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CREATING LOGIC

The purpose of this manual is to describe the logic generation tools and
their uses, not programming techniques. Only fully qualified and trained
personnel should attempt logic generation.

There are 14 types of logic elements available for use in any order or
combination desired. 

Each logic page can have up to 32 logic elements. 

Every element placed on the screen with the exception of connecting
lines and descriptive text are counted against the 32 possible elements
on a page.

The basic sequence for creating logic is as follows:

1. Place input gates on the page and configure them. To configure a
gate, double click on the gate and select the appropriate parame-
ters from the gate edit screen.

2. Place logic gates on the page and connect to the appropriate
inputs.
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3. Place output gates on the page, configure them, and connect their
inputs to the appropriate logic element outputs. To configure a gate,
double click on the gate and select the appropriate parameters from
the gate edit screen.

4. Verify the logic page.

5. Download the logic page to the logic controller.

DOWNLOADING LOGIC

When all the logic has been created and the network variables are con-
figured, the data must be downloaded to the logic controller.

To upload/download single/multiple logic pages, network variables,
and LIOU configuration data:

1. Place the key switch on the Logic Controller in the RESET position.
After approximately one second, the Program LED turns on.

2. Select Upload or Download from the File menu.

3. Return the key switch to the Normal position when the procedure is
complete.

WRITING CONFIGURATION TO EEPROM

Once the logic and configuration data has been downloaded and
checked out, the information should be written to EEPROM in the Logic
Controller to allow it to survive a power loss.

To write the logic to EEPROM:

1. Place the key switch on the Logic Controller in the RESET position.
After approximately one second, the Program LED turns on.

2. Select Write EEPROM from the File menu.

3. Return the key switch to the Normal position when the procedure is
complete.

PRINTING LOGIC PAGES

To obtain a permanent record of all custom logic, from the Logic screen
select Print under the File menu. EagleVision-NT will print all logic pages
with identification of all logic inputs and outputs.
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DRAWING LINES

To connect points on the drawing, place the cross icon on one point,
then drag to the other point.

To delete a line, use the pointer tool, click on the end of the line that is
an input connection to a gate, then drag the line off the connection and
release. The line will be deleted.

COLORING

To color a gate or the box surrounding the text field, select the object to
be colored, then select the desired color from the palette in the upper
right hand corner of the screen.

RENUMBERING GATES

Each gate is numbered sequentially as it is placed on the logic page.
To change gate numbers, select Gate Order under the Edit menu. Place
the cursor on the gate to be renumbered, then click. The number to the
right of the cursor will be applied to the gate.

DETERMINING GATE STATUS

To determine the current status condition of the gates on a logic page,
select Status under the View menu. The input / output status (digital “0”
or “1”) will be displayed for each gate. Click on Status again to return
to the Normal screen view.

LOGIC ELEMENTS

Refer to Figure V-19 for identification of the logic tools.
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Selection Tool

The “arrow” selection tool (pointer) is used for selecting objects and
moving them around the screen.  Multiple object selections are made by
clicking and dragging the selection rectangle around all objects to be
selected, or by holding down the shift key while clicking on each object
to be selected.  Objects are deleted by first selecting them and then
using the “delete” key on the keyboard.

Text Tool

The text (label) tool is used to place text fields on the drawing. To place
a text field, select this tool, then click on the location where it will be
placed. Double click on the text field. The Label Edit Form dialog box
will be displayed. Enter the desired text in the space provided, then click
on OK. To change the characteristics of the text, select “Font” under the
Edit menu.

Input Gate

Used for assigning physical and LON/SLC inputs to the logic.

To place an Input Gate, select this tool, then click on the location where
it will be placed. Double click on the gate to display the Input Gate Edit
screen. See Figure V-20. Select the desired input parameters from the
pull down menus, then click on OK.
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TEXT TOOL

INPUT GATE

OUTPUT GATE

AND GATE

OR GATE

NOT GATE

LESS THAN GATE

GREATER THAN GATE

EQUALS GATE

LESS THAN EQUAL GATE

GREATER THAN EQUAL GATE

LATCH GATE

INTEGER ADDER GATE

BINARY COUNTER GATE

TIMER GATE

FIGURE V-19

Logic Tools



Output Gate

Used for assigning physical outputs.

To place an Output Gate, select this tool, then click on the location
where it will be placed. Double click on the gate to display the Output
Gate Edit screen. See Figure V-21. Select the desired output parameters
from the pull down menus, then click on OK.

The output defaults to a “0” or “off” condition if there is no input to the
gate.

Do not assign an output more than once as unpredictable and undesir-
able results can occur.
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AND Gate

Eight input logical “AND” gate.

To place an AND Gate, select this tool, then click on the location where
it will be placed.

Unused inputs are evaluated as a “1.”

OR Gate

Eight input logical “OR” gate.

To place an OR Gate, select this tool, then click on the location where
it will be placed.

Unused inputs are evaluated as a “0.”

NOT Gate

Logical inverter. A “1” in = a ”0” out.

To place a NOT Gate, select this tool, then click on the location where
it will be placed.

Less Than Gate

Less than “n” gate. Accepts a single integer input from a Binary Adder
or Integer Counter, compares it to “n” and creates a binary output.

To place a Less Than Gate, select this tool, then click on the location
where it will be placed. To assign a value to “n,” double click on the
gate, then enter the value in the Preset box.

Greater Than Gate

Greater than “n” gate. Accepts a single integer input from a Binary
Adder or Integer Counter, compares it to “n” and creates a binary out-
put.

To place a Greater Than Gate, select this tool, then click on the location
where it will be placed. To assign a value to “n,” double click on the
gate, then enter the value in the Preset box.

Equals Gate

Accepts a single integer input from Binary Adder or Integer Counter,
compares it to “n” and creates a binary output.
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To place an Equal To Gate, select this tool, then click on the location
where it will be placed. To assign a value to “n,” double click on the
gate, then enter the value in the Preset box.

Less Than/Equal to Gate

Less than or equal to “n” gate. Accepts a single integer input from a
Binary Adder or Integer Counter, compares it to “n” and creates a bina-
ry output.

To place a Less Than/Equal To Gate, select this tool, then click on the
location where it will be placed. To assign a value to “n,” double click
on the gate, then enter the value in the Preset box.

Greater Than/Equal to Gate

Greater than or equal to “n” gate. Accepts a single integer input from
a Binary Adder or Integer Counter, compares it to “n” and creates a
binary output.

To place a Greater Than/Equal To Gate, select this tool, then click on
the location where it will be placed. To assign a value to “n,” double
click on the gate, then enter the value in the Preset box.

Timer Gate

To place a Timer Gate, select this tool, then click on the location where
it will be placed. See Figure V-22. 

Double click on the gate. The Timer Preset dialog box appears. See
Figure V-23.
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Select the desired timer type and time base. In the Preset box, enter the
value that the timer counts to. In the Preload box, enter the value where
the timer begins counting.

Latch Gate

To place a Latch/Unlatch Gate, select this tool, then click on the loca-
tion where it will be placed.

See Table V–3.

Integer Adder Gate

Accepts up to 8 integer inputs (from Binary Counters) and outputs an
integer sum.

To place an Integer Adder Gate, select this tool, then click on the loca-
tion where it will be placed.
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Timer Preset Screen

Input Output
S R S R
0 0 no change no change
1 0 1 0
0 1 0 1
1 1 0 1

TABLE V-3

Latch/Unlatch Gate



Binary Counter Gate

Accepts up to 8 binary inputs and develops an integer output that is the
sum of the inputs.

To place a Binary Counter Gate, select this tool, then click on the loca-
tion where it will be placed.
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To configure the computer running EagleVision-NT for communication
with the gateway, select Config under the File menu. The
Communication Port Configuration screen will be displayed. See Figure
IV–1.

Type a tag name for the LON in the LON Name box. This name will
appear on the tab in the lower left corner of the screen and is also used
as a prefix for the Wonderware tagnames. It should be kept as short as
practical.

Select Eagle 2000  in the box labeled Gateway.

Enter the desired values in the Modbus Address, Com Port, Baud Rate,
Stop Bits, Parity and Data Bits fields. When gateway port 0 is used, the
values are fixed at 9600 baud, even parity and 1 stop bit. When gate-
way port 1 is used, the values selected in these fields must match the
gateway DIP switch settings for baud rate, stop bits, parity and data
bits. Refer to the Eagle 2000 hardware instruction manual (form num-
ber 95-8424) for complete switch setting information.

Modbus Address must match the value set on the gateway Modbus
address DIP switches, S7. When gateway port 1 is used, the address is
set using the gateway’s DIP switches. When gateway port 0 is used, the
address is set using software from the Gateway Configuration screen.
The default address is 1.

Com Port defines which PC serial port is connected to the gateway.
Clicking on the button next to Com Port initiates a routine in which the
software systematically tries all valid combinations of baud rate, data
bits, and parity. If a connection is successfully established, the software
will fill in the appropriate values.

Writes Count tracks the number of outgoing messages to the gateway. 

Reads Count tracks the number of responses. These two numbers
should track each other, however, a small disparity does not necessari-
ly indicate a problem. 

Average Poll Time is the amount of time for the gateway to respond
to the message.

ERRORS

This data indicates communication errors. These values can be helpful
in diagnosing communication problems.
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CRC (Cyclical Redundancy Check) is an error checking method. This
field is incremented when the calculated CRC value is different than the
transmitted value. This error is typically caused by incorrect serial com-
munication settings.

Data. This field tracks the number of response messages that have the
wrong data size.

Com. This field tracks the number of serial communication errors report-
ed by the operating system.

Command. This field tracks the number of Modbus error responses.
This can occur if the gateway is not configured properly. Check the set-
ting of the Main/Aux gateway DIP switch.

Timeouts. This number is incremented each time the gateway does not
respond to the message from the OIS.

When correct communication is established, the read and write counts
should match, with zeros displayed in the Error boxes.

BUTTONS

Close closes this window.

Add creates a new LON.

Cancel cancels the entry.

Reset Counts resets the counters.

Delete deletes the LON.

Refer to “Device Trigger Configuration” in “Section V — Eagle Quantum
System Configuration” for complete information regarding trigger lists.

Addresses 1 through 4 are reserved for gateways only. Address num-
ber 1 should be used for the main gateway and 2 to 4 for auxiliary
gateways (if used).

1. Highlight line 1 on the Point Configuration screen. Click on the
Modify Point button.

2. Click on the Define button. Select the gateway type, then click on
OK. The Gateway Configuration screen will be displayed. See
Figure VI–1.
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3. Type a tag name for the point in the space provided.

4. Assign a trigger for the point.

5. Select gateway type and fill in the appropriate port configuration
data. These settings are determined in conjunction with the gateway
DIP switch settings. Refer to the Eagle 2000 hardware instruction
manual (form number 95-8424) for switch setting information.

Port 2 of the Gateway can be configured for either Modbus master
or slave operation. 

As a Modbus RTU master, it actively “feeds” a copy of its datatables
to a slave PLC. When set for the master mode, enter the PLC address
in the Modbus Address field under Port 2 Config. 

When set for the slave mode, enter the gateway address in the
Modbus Address field. (The address in the Modbus Address field
should be the address of the slave device.)

The Master Data Offset specifies where in the slave PLC’s register
memory (40,000 registers) the data from the Eagle system will
begin.
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6. Enter a starting and an ending address for each of the four gateway
relays. These numbers identify a specific “block” of addresses that
will be monitored by each gateway relay. Then check the appropri-
ate boxes to select the event(s) that will actuate each of the relays.
The fault relay will be actuated upon detection of a LON fault (LON
open or shorted) or an internal gateway fault (self-diagnostic test
failure).

7. Check the appropriate “Energized” button if a normally energized
relay coil is desired. The coil will become de-energized when the
relay status becomes active.

8. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.

2. Click on the Define button.  

3. Click on the Communication Module button, then click on OK. The
Communication Module Point Configuration screen will be dis-
played. See Figure VI–2.
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4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point.

6. Refer to the Eagle 2000 System Configuration Matrix (form number
95-8453) to determine the correct configuration number for the
device. Use the scroll arrows or type this number in the “Config
Number” box in the upper right hand corner of the screen. The oper-
ating parameters for the configuration number are displayed in the
various fields of the Point Configuration screen. These values will
automatically change to match the configuration number that is
entered.

7. Click on the Defaults button to display the default values for cali-
bration gas, high and low alarm setpoint, and update rate. If other
values are desired, enter them in the appropriate boxes labeled
“Now.”

WHEN A K FACTOR IS USED

If the sensor is calibrated using a gas type that is different than the
gas being detected, a calibration “K factor” must be used. (Refer to
Det-Tronics Technical Note No. GTN01 for complete information
regarding the use of K factors.)

If a K factor is used for sensor calibration, a similar adjustment
should be made when entering the calibration gas value at the OIS.
Use the following formula to determine the correct value to be
entered in the box labeled “Now” under Cal. Range. This will
ensure the most accurate gas level reading at the OIS.

C  x  K  =  S

C  = Concentration of calibration gas in % LFL
K  = K factor for the gas to be monitored (from Table 1 in GTN01)
S  = Corrected calibration output level

(Enter this value in the box labeled “Now” under Cal. Range).

8. Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.

A relay node monitors a specified group of nodes on the loop and gen-
erates an output when the selected conditions for output actuation are
met.

1. Highlight the desired address on the Point Configuration screen.
Click on the Modify Point button.
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2. Click on the Define button. 

3. Click on the Relay Node button, then click on OK. The Relay Node
Configuration screen will be displayed. See Figure VI–3.

4. Type a tag name for the point in the space provided.

5. Assign a trigger for the point. 

6. Select the operating mode. 

Start/End mode: Relay node responds to addresses in the speci-
fied range. Only the starting and ending address-
es are specified. All detectors within the range of
contiguous points will be monitored. 

List mode: Only messages from device addresses specified
on the list will be processed.

7. Enter the addresses to be monitored in the appropriate “Source
Addresses” boxes.

NOTE
Clicking on the Defaults button will clear all entered source
addresses.
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8. Select the desired Trigger  bits.  

Trigger bits represent the eight possible communication module sta-
tus events that can be monitored by the relay module.

Com 1/Com 2 — Communication fault.
Sensor Fault — Includes improperly wired sensor, sensor

input below the threshold for normal
operation, or invalid configuration.

In Calibration — Calibration in progress.
High/Low Alarm — Alarm condition.
Digital Input — Communication module’s digital input

active.
Output Relay — Communication module’s relay is active.

9. Select the desired I/O conditions in the Input/Output box.

Relay Energize. Check this box if a normally energized relay coil
is desired. The coil will become de-energized when the status of the
device becomes active.

Latching. When Start/End mode is selected, the output relay is
always latching. If List mode is selected, check this box if latching
relay operation is desired.

Invert Input. The normal status for the inputs is 0 with the input
open (active status is 1 with input closed). This option is provided to
allow for the use of a normally closed input.

10.If List Mode is selected, enter in the “Voting” box the number of
detectors within the group that must register an active Trigger Bit for
the Relay Node to actuate.

11.Enter the desired update rate.

12.Click on Accept. Click on Close to exit and return to the Point
Configuration screen, or use the scroll arrows to select the next point
for configuration.
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Point display screens provide detailed status information for each con-
figured point on the network. Information provided on the point display
screens includes:

• current analog value (displayed as bar graph and in engineering
units)

• alarm setpoint levels
• communication status
• sensor status
• relay status
• calibration status and history
• alarm status and history.

All point display screens share the following common fields.

Point Name is displayed in the upper left hand corner of the screen.

LON Name and Point Number are displayed in the upper right
hand corner of the screen.

Goto Point, Next Point and Previous Point buttons allow the
operator to navigate from one point to another.

Inhibit button toggles the status of the inhibit bit. When a point is inhib-
ited, the gateway relays and display are inhibited from responding to
changes in the status of this point.

Close button closes this screen and returns to the previously displayed
screen.

Status Indicators are normally black and turn red when active. In a
properly operating system with no faults or alarms occurring, all indi-
cators are off with the exception of the LON Master on the Gateway
Point Display screen.

From the Point Configuration screen, highlight the gateway, then click
on Display Point or select Point from the View menu. The Gateway Point
Display screen will be displayed. See Figure VII–1.
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INDICATORS

Upper Xcever Fault and Lower Xcever Fault. These bits indi-
cate that the self-diagnostic tests have detected a malfunction in one of
the LON communication transceivers. Reset the gateway by cycling
power. If the fault continues, replace the gateway.

Gateway Fault. This bit is set when the self-diagnostic test has detect-
ed an internal problem with the gateway. Reset the gateway by cycling
power. If the fault continues, replace the gateway.

LON Relay Override. This bit indicates that the user has overridden
the normal function of the gateway’s LON relay. The LON relay is used
to connect the ends of the network in the event of a LON fault. While
troubleshooting, it is helpful to override the automatic function of this
relay. However, it is critical to return the relay to the automatic mode
after troubleshooting is completed.

Invalid Configuration. This bit indicates that the gateway has not
been configured or that the configuration does not match the DIP switch
setting.

Unable to Configure. The main gateway was unable to successfully
transfer configuration data to an auxiliary gateway.

Not Communicating. This bit is set when any configured gateways
fail to report on schedule.
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Inhibit Active. This bit indicates that the gateway relays and display
are inhibited from responding to changes in the gateway’s status word.
The status is controlled by the “Inhibit” button.

LON Master. This bit is used to indicate which gateway is currently
sending the time and date heartbeat messages. This bit is normally on
for main gateways and off for auxiliary gateways. If auxiliary gateways
or logic controllers do not hear the heartbeat messages from the main
gateway, they will send the heartbeat messages and set this bit.

LON Fault. This bit is set when the time and date message sent out
from one side of the gateway is not being received by the other port,
indicating the presence of a short or open on the network. This bit is set
any time that a short or open condition occurs on the network.

Slave PLC. This bit is set to indicate that an attached PLC is respond-
ing.

Net Test Fault. The main gateway periodically sends the time and
date heartbeat messages in the opposite direction to test for failed net-
work extenders. This bit is set to indicate a test failure. The bit will
remain set until the system passes the test. The test is conducted once
every 20 minutes.

Fault Relay Active. This bit is set when the gateway fault relay is
active. The relay is triggered when an open is detected on the LON or
a gateway fault is detected.

BUTTONS

Reset Relay buttons are used to reset the gateway relays when set for
latching operation.

From the Point Configuration screen, highlight the logic controller, then
click on Display Point or select Point from the View menu. The Logic
Controller Point Display screen will be displayed. See Figure VII–2.
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FAULTS

Upper or Lower Xcever Fault. These bits indicate that the self-diag-
nostic tests have detected a malfunction in one of the two LON commu-
nication transceivers.

LON Fault. This bit is set when the logic controller is not receiving
heartbeats from the main gateway.

Unable to Configure. This bit indicates that the main gateway was
unable to successfully transfer configuration information to the logic con-
troller.

Invalid Configuration. The invalid configuration status is active until
configuration information is downloaded. Changing the logic controller
address will cause the invalid configuration status to indicate that recon-
figuration is required.

Not Communicating. This bit is set when the logic controller fails to
report on schedule.

EEPROM CRC. Using a cyclical redundancy check method, the auto-
matic self-diagnostic test has revealed a problem with the non-volatile
memory. The logic controller must be replaced if this error occurs.

Ram Fault. This bit is active after new configuration information has
been downloaded but not saved in non-volatile memory. Performing the
“Write EEPROM” function will clear this fault.
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NV Communicating. This bit is set when a field device is not report-
ing to the logic controller. The Detect NV Comm button can be used to
identify any devices that are not reporting.

Detect NV Comm. This feature is used to identify field devices that
are not reporting to the logic controller. A listing of all field devices and
their current communication status will be provided in the box in the
lower left hand corner of the screen.

LOGIC CONTROLLER STATUS

Fire Alarm. This bit tracks the Alarm LED on the logic controller face-
plate. The fire alarm status bit is activated when any enabled fire input
is active. This includes all flame detectors and IDC inputs that are con-
figured as alarm type inputs. The bit is latching and will remain active
until the logic controller is reset.

Trouble. This bit tracks the Trouble LED on the logic controller face-
plate. Once the trouble bit is set, it can only be cleared by resetting the
logic controller. The trouble bit is set when any of the following faults
are active:

• LIOU Not Communicating
• AC Failed
• Battery Fault
• LIOU Wire Fault
• Power Supply Fault
• Power Trouble
• LIOU Too Many Cards
• Invalid Configuration
• Upper Xcvr Fault
• Lower Xcvr Fault
• LON Fault
• NV Input Not Communicating
• GW LON Fault
• RAM Fault.

Supervisory. This bit tracks the Supervisory LED on the logic controller
faceplate. The supervisory status bit is set when any enabled LON input
has a supervisory fault. The bit is latching and remains set until the logic
controller is reset.

Acknowledge. The acknowledge status bit is set after the acknowl-
edge switch on the logic controller faceplate is activated. It indicates
that the operator has acknowledged an alarm condition and silenced
the internal beeper. The bit is latching and will remain set until the logic
controller is reset.
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Silence. The silence status bit is set after the Silence switch on the logic
controller faceplate is activated. It indicates that the operator has
silenced the external horns. The bit is latching and will remain set until
the logic controller is reset.

Isolated. The isolated status bit indicates that the logic controller key
switch is in the Isolate position. The Isolate function is provided to aid in
maintenance of releasing type outputs. The operator must provide cus-
tom logic to send this signal to agent release output devices in the field.

Program Mode. This bit indicates that the logic controller is in the
Program mode and is ready to receive configuration information. The
fixed fire and operator logic is stopped in this mode.

Inhibit Active. This bit indicates that the gateway relays and display
are inhibited from responding to changes in the logic controller’s status.
The status is controlled by the “Inhibit” button.

EEPROM Write. This bit indicates that configuration information is cur-
rently being copied from RAM memory to non-volatile memory. This is
initiated by the operator after new configuration information is down-
loaded in the logic controller.

GW LON Fault. This bit is set when the logic controller receives a
LON fault message from the gateway. The gateway will set this bit when
the LON is open and clear it when it is closed. This is done to allow the
logic controller to signal trouble in the event of a LON fault.

POWER SUPPLY FAULTS

AC Failed. The AC Failed fault bit is set when any of the
EQ2100LCUPS power supplies has low or missing AC input voltage.

Power Trouble. The power trouble bit is set when a general power
related fault has been detected.

Power Supply Fault. This bit signals a problem with the
EQ2100LCUPS Power Supply. The bit is latching and remains set until
the logic controller is reset.

Battery Fault. This bit is set when any of the EQ2100LCUPS power
supplies has low or missing batteries.

IO FAULTS

All IO Faults relate to the EQ2100LCUPS power supplies or
EQ2100LIOU devices.
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IO Communication Fault. This bit signals a general fault with the
RS-485 communication with the EQ2100LIOU boards or
EQ2100LCUPS power supply.

IO Board Count. This bit is set when an EQ2100LIOU board is
detected that is not on the list of configured boards. Use the “Detect
Cards” feature to locate the problem (accessed by pressing the
Diagnostic button).

IO Wire Fault. This fault bit is set when any of the EQ2100LIOU
boards have an open or shorted wire. Check the individual card status
to locate the cause of the problem.

IO CPU Reset. This fault bit is set when any of the EQ2100LIOU
boards has been reset. Check the card status to locate the card that has
been reset.

IO Not Communicating. This bit is set when one or more of the con-
figured IO boards is not responding. Check the card status to locate the
card that is not responding.

LIOU CARD STATUS

When the Card Status button is pressed, a tabbed notebook is dis-
played on the lower part of the screen. The tabs are numbered 1 to 24
to represent the maximum number of LIOU boards and LCUPS power
supplies. Each page of the notebook displays the current status of the
device installed at that location. The last tab is labeled LH (local hard-
ware).

Sounder Board

See Figure VII–3. The Sounder board has open and shorted fault con-
dition indicators for each of the 4 supervised output circuits.

CPU Reset — status is activated for 60 seconds when a board is reset
from power-up, by the watchdog timer, or by pressing the reset switch
on the board.

Wrong Style Cir — activated when the software configuration does
not match the DIP switch setting on the board.

Not Communicating — board is not responding.
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Relay Board

See Figure VII–4. Each Relay board has 4 unsupervised output circuits. 

CPU Reset — status is activated for 60 seconds when the board is
reset from power-up, by the watchdog timer, or by pressing the reset
switch on the board.

Not Communicating — board is not responding.

Agent Release Board

See Figure VII–5. Each Agent Release board has one release output and
three supervised signal audible outputs. The first three indicators show
the status of the release output — open, active or isolated. 

CPU Reset — status is activated for 60 seconds when the board is
reset from power-up, by the watchdog timer, or by pressing the reset
switch on the board.

Wrong Configuration — the software configuration does not match
the S3-1 DIP switch setting on the board (Initiator/Solenoid). 
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Circuit Open and Circuit Short — open or shorted status of signal
audible output. 

Not Communicating — board is not responding.

Power Supply Monitor.

See Figure VII–6. The power supply monitor is capable of monitoring up
to 2 SMPSs (Switchable Mode Power Supplies) and one battery charg-
ing circuit. During the configuration process, the operator selects if one
or two supplies are being monitored.

AC Fail — low or missing AC input voltage is detected.

Ground Fault Pos and Ground Fault Neg — a ground fault has
been detected in the 24 volt power circuit.

SMPS 1 Present and SMPS 2 Present — the power supplies are
present.

SMPS 1 Failed and SMPS 2 Failed — power supply failure.

Battery Failed — battery is missing.
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Low Battery — battery voltage is out of tolerance.

Battery Test Active — feature is not supported.

CPU Reset — status is activated for 60 seconds when the board is
reset from power-up, by the watchdog timer, or by pressing the reset
switch on the board.

Battery Current Ma — less than one ampere of current is flowing
between the power supply and batteries.

No Battery Test — too soon to conduct a battery test.

Not Communicating — board is not responding.

Local Hardware.

See Figure VII–7. The Local Hardware display shows the current state of
the logic controller’s hardware.

Normal, Enable, Program and Isolate — current status of the
faceplate key switch.

Ground Fault and LON Ground Fault — faults detected by the
LON Isolator module.

Ack Switch and Silence Switch — these bits track the status of the
pushbutton switches on the logic controller faceplate.

Alarm Relay, Trouble Relay and Supervisory Relay — these
bits track the current status of the relays.
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User Switches — these bits track the status of the local digital inputs.

NV Output Failed — logic controller was unable to communicate
with a LON output device like a SAM or ARM.

PROCESS VARIABLE DISPLAY

The gas level / process variable is graphically displayed on an analog
bar graph. See Figure VII–8. The scaling and engineering units will
change depending on the type of gas and configuration settings.

STATUS INDICATORS

Low Voltage. This bit is set when the input power voltage to the DCU
is below 17.5 volts. The actual voltage can be read from the “Network”
screen. The typical cause of this fault is under-sized wire.

Com 1 and Com 2. One of these bits is set when the DCU’s fault iso-
lation circuitry has detected and isolated a wiring fault.

Unable to Configure. This bit is set by the gateway when it is unable
to successfully transfer configuration information to the DCU.

Power up. This bit is set during the power-up time delay.
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Not Communicating. This bit is set by the gateway when it does not
receive periodic status messages from the DCU. The bit is cleared when
a new status update is received.

Inhibit Active. This bit indicates that the gateway relays and display
are inhibited from responding to changes in the DCU status. The Inhibit
Active status is controlled by the “Inhibit” button.

Sensor Fault. This bit is set when the gas level is below the fault
threshold or the Invalid Configuration bit is set.

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

Auto Config Fault. This bit indicates that the gateway was unable to
successfully download configuration information.

CALIBRATION INFORMATION

In Calibration. This bit is active during the sensor calibration proce-
dure.

Calibration Fault. This bit is set when a fault is detected during the
calibration procedure.

Calibration History. The DCU stores the baseline and the last seven
calibration records (date, time, high and low calibration values). These
records allow the operator to spot trends in sensor sensitivity or poten-
tial problems. Clicking in the calibration history box will bring up a
graphic representation of the calibration history.

ALARM INFORMATION

High and Low Alarm. The alarm indicator is on when the gas con-
centration exceeds the alarm setpoint and clears when the level returns
below the setpoint. The current alarm setpoint values are also displayed.
The alarm setpoint values are selected on the point configuration screen.

Alarm History. The DCU stores and displays the last eight alarms
(high and low). The display includes the type of alarm and the time and
date stamp.
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From the Point Configuration screen, highlight the IDC, then click on
Display Point or select Point from the View menu. The IDC Point Display
screen will be displayed. See Figure VII–9.

STATUS INDICATORS

Low Voltage. The low voltage bit is set when the input power voltage
to the IDC is below 17.5 volts.

Com 1 and Com 2. One of these bits is set when the IDC’s fault iso-
lation circuitry has detected and isolated a LON wiring fault.

Unable to Configure. This bit is set by the gateway when it was
unable to successfully transfer configuration information to the IDC.

Inhibit Active. This bit indicates that the gateway relays and display
are inhibited from responding to changes in the IDC status. The Inhibit
Active status bit is controlled by the “Inhibit” button.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the IDC. The bit is cleared when a new status update is received.
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Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

Auto Config Fault. This bit indicates that the gateway was unable to
successfully download configuration information.

INPUT 1 / INPUT 2

The open indicator turns on if the input is not properly terminated, if a
wire is open, or if the device being monitored is in fault.

The active indicator turns on when the input circuit is closed.

The mode field shows how the input is configured — Alarm, Trouble,
Supervisory, or other. This can be changed on the IDC configuration
screen.

SWITCHES

This area shows the current status of the four DIP switches on the IDC
CPU board.

ALARM ADDRESSES

This area shows the addresses of the logic controllers that are config-
ured for communication with this IDC. All alarm and trouble status infor-
mation will be sent to the addresses listed here. The addresses can be
changed on the IDC configuration screen.

INPUT HISTORY

The IDC stores the time, date, and input type of the last eight activations.
This information is displayed by clicking on the Fetch Logs button.

UPDATE RATE

This field shows in milliseconds how often the IDC will report its status
to the gateway. The update rate is programmable from 1 to 10 seconds
on the IDC configuration screen.

FETCH LOGS BUTTON

This button will retrieve the input activation logs.
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From the Point Configuration screen, highlight the UV Flame Detector,
then click on Display Point or select Point from the View menu. The UV
Flame Detector Point Display screen will be displayed. See Figure
VII–10.

BAR GRAPH DISPLAY

The bar graph shows the current UV signal in counts per second (cps).
Two scales are displayed, a blue bar shows the signal level from 0 to
100 cps and a red bar is 10 times the scale (0 to 1000 cps). In normal
operation, the signal should read zero. When an automatic Oi (optical
integrity) test is performed, a small signal level is visible. A signal is also
visible when a manual Oi test is performed or when an external UV
source is detected.

STATUS INDICATORS

Low Voltage. This indicator turns on when the input power voltage to
the UV flame detector is below 17.5 volts.

Com 1 and Com 2. One of these bits is set when the fault isolation
circuitry in the UV detector has detected and isolated a LON wiring
fault.

Manual Oi Fault. This indicator turns on when the UV detector fails
a manually initiated Oi test.
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Unable to Configure. This bit is set by the gateway if it was unable
to successfully transfer configuration information to the UV flame detec-
tor.

Inhibit Active. This bit is set when the gateway relays and display are
inhibited from responding to changes in the UV flame detector status.
The inhibit active status bit is controlled by the “Inhibit” button.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the UV flame detector. The bit is cleared when a new status update
is received.

Oi Test Started. This indicator turns on when a manual Oi test is per-
formed. It is not activated for automatic Oi tests.

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

Auto Oi Fault. This bit turns on when the UV detector fails the auto-
matic Oi test. The automatic Oi test is performed once per minute. A
fault is generated if the detector fails three consecutive tests. The fault is
cleared when the detector passes three consecutive tests.

Pre Alarm. This bit turns on upon the first indication of fire or if an
alarm is generated by a background source of UV.

Sensor Init Fault. When automatic Oi is turned off, the detector will
perform an initial automatic Oi test on power-up. This is done to ensure
that the UV tube module is properly installed. The indicator turns on if
the detector fails the test. The fault is latching and can be cleared with
a successful manual Oi test.

290 Volt Fault. This bit is set when the high voltage power supply for
the UV tube module is not within the allowed tolerance.

Auto Configuration Fault. This bit indicates that the gateway was
unable to successfully download configuration information.

Fault. This bit is set for all fault conditions and tracks the trouble signal
sent to the logic controller.

Alarm. This bit is set when all fire alarm criteria are met.  
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UPDATE RATE

This field shows in milliseconds how often the detector will report its sta-
tus to the gateway. The update rate is programmable from 1 to 10 sec-
onds on the UV detector configuration screen.

SENSITIVITY, TIME DELAY, AND ARC REJECTION

This area displays the fire response configuration parameters. These
parameters are  programmable from the UV detector configuration
screen.

DETECTOR MODE

Processing mode. This field indicates whether the detector is config-
ured for standard or arc rejection signal processing mode.

Oi. This field shows if the detector is configured for automatic optical
integrity testing. Manual Oi testing is always available.

Latching. This field indicates whether the detector’s alarm output is
configured for latching or non-latching operation. If latching mode is
selected, the detector can be reset with the Reset button.

ALARM ADDRESSES

This area lists the addresses of the logic controllers that are configured
for communication with this UV detector. All alarm and trouble status
signals will be sent to the addresses listed here. The addresses can be
changed on the UV detector configuration screen.

ALARM HISTORY

The UV detector stores the time and date of the last eight fire alarms.
This information is displayed by pressing the Fetch Logs button.

BUTTONS

Reset. This button resets the alarm condition when latching operation
is selected.

Start Oi Test. This button initiates a manual Oi test. The test will run
for a pre-determined length of time and will end automatically. If the
detector fails the test, the manual Oi fault bit is set.

Fetch Logs Button. This button will retrieve the alarm logs.
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From the Point Configuration screen, highlight the UV/IR Flame
Detector, then click on Display Point or select Point from the View menu.
The UV/IR Flame Detector Point Display screen will be displayed. See
Figure VII–11.

BAR GRAPH DISPLAY

The bar graph display shows the current UV or IR signal in counts per
second (cps). The “Display IR / UV” button allows the operator to switch
between the two channels. Two scales are displayed for each channel
— a 1x (times 1) and a 10x (times 10). In normal operation, the UV sig-
nal should be zero and the IR signal should be a low level between 5
and 15 cps. When an automatic Oi (optical integrity) test is in progress,
a small signal level is visible. A small signal is also visible when a man-
ual Oi test is performed, or when a background UV or IR source is
detected.

STATUS INDICATORS

Low Voltage. This indicator turns on when the input power voltage to
the detector is below 17.5 volts.

Com 1 / Com 2. One of these bits is set when the fault isolation cir-
cuitry in the detector has detected and isolated a LON wiring fault.
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IR Alarm. This indicator turns on when the IR alarm criteria are met.

Unable to Configure. This bit is set by the gateway when it was
unable to successfully transfer configuration information to the UV/IR
flame detector.

Inhibit Active. This bit turns on to indicate that the gateway relays
and display are inhibited from responding to changes in the UV/IR
flame detector status. The inhibit active status bit is controlled by the
“Inhibit” button.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the flame detector. The bit is cleared when a new status update is
received.

UV Alarm. This indicator turns on when the UV alarm criteria are met.

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

UV Fault. This bit is set when a fault relating to the UV sensor is detect-
ed. Press the extended status button to locate the source of the problem.

IR Fault. This bit is set when a fault relating to the IR sensor is detect-
ed. Press the extended status button to locate the source of the problem.

Power-Up. This indicator is on while the detector is conducting self-
diagnostics after re-application of power.

Auto Configuration Fault. This bit indicates that the gateway was
unable to successfully download configuration information.

Fault. This bit is set for all fault conditions and tracks the fire trouble
signal sent to the logic controller.

Fire Alarm. This bit tracks the fire alarm signal sent to the logic con-
troller, and turns on when both the UV and IR fire alarm criteria are met.

UPDATE RATE

This field shows in milliseconds how often the UV/IR detector will report
its status to the gateway. The update rate is programmable from 1 to 10
seconds on the UV/IR detector configuration screen.
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SETTINGS DISPLAY

UV/IR Sensitivity. This field shows the sensitivity settings for the UV
and IR sensors. The UV setting is on the left, while the IR sensitivity is on
the right. The sensitivity settings can be adjusted from the UV/IR detec-
tor configuration screen.

Arc Rejection. This field indicates whether the UV sensor is configured
for standard or arc rejection signal processing mode.

Time Delay. This field shows the selected alarm time delay. The fire
must be present for this amount of time to be considered an alarm. The
time delay can be adjusted from the UV/IR configuration screen.

IR Oi Sensitivity. This field shows the selected Oi sensitivity setting for
the IR sensor. When low sensitivity is selected, the IR sensor will fault
with less contamination on the viewing window than when medium or
high sensitivity is selected. The IR Oi sensitivity setting can be adjusted
from the UV/IR detector configuration screen.

Processing Mode. This field indicates whether the UV sensor is con-
figured for standard or arc rejection signal processing mode. This can
be adjusted from the UV/IR detector configuration screen.

Oi. This field indicates if the detector is configured for automatic opti-
cal testing. Manual Oi testing is always available.

Oi Test Frequency. This field shows how often the IR sensor will be
automatically tested. The setting can be changed on the UV/IR detector
configuration screen.

Latching. This field indicates whether the detector’s alarm output sig-
nal is configured for latching or non-latching operation. If latching mode
is selected, the unit can be reset with the reset button.

Alarm Destination Addresses. This area shows the addresses of
the logic controllers that are configured for communication with this
UV/IR detector. All alarm and trouble status signals will be sent to the
addresses listed here. The addresses can be changed on the UV/IR
detector configuration screen.

ALARM HISTORY

The detector stores the time and date of the last eight fire alarms. This
information is displayed by pressing the Fetch Logs button.
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BUTTONS

Reset
This button resets the alarm condition when latching operation is select-
ed.

Start Oi Test
This button initiates a manual Oi test on the selected channel. The test
will run for a pre-determined time and end automatically. If the detector
fails the test, the UV or IR manual Oi fault bit is set.

Fetch Logs
This button will retrieve the alarm logs. 

Display UV/IR
This button toggles the bar graph display between UV and IR.

Extended Status
Pressing this button will retrieve additional fault diagnostic information
from the detector. See Figure VII-12. This information can be used to find
the source of the problem when the UV or IR fault indicators are on.

UV Automatic Oi Fault. This indicator is on when the UV detector
has failed the automatic Oi test. To correct the problem, clean the detec-
tor viewing window and Oi ring. The fault will self-clear after the detec-
tor passes three consecutive automatic Oi tests.

UV Manual Oi Fault. This indicator turns on after an unsuccessful
manual Oi test. The fault will clear after a successful test is completed.
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Missing UV Tube Fault. When automatic Oi is turned off, the detec-
tor will perform an initial automatic Oi test on power-up. This test
ensures that the UV tube module is properly installed and operating. The
indicator turns on if the detector fails the test. The fault is latching  and
can be cleared with a successful manual Oi test.

290 Volt Fault. This indicator turns on when the UV tube module high
voltage power supply is not within the allowed tolerance.

Manual UV Oi Test Active. This bit is set while a manual Oi test is
in progress.

IR Automatic Oi Fault. This indicator is on after the IR detector has
failed the automatic Oi test. To correct the problem, clean the detector
viewing window and Oi ring. The fault will self-clear after the detector
passes three consecutive tests. If the fault continues to occur, the IR Oi
threshold may require adjustment.

IR Manual Oi Fault. This indicator turns on when an unsuccessful
manual Oi test is conducted. The fault will clear after a successful test is
completed.

Missing IR Module. On power-up, the detector looks for background
signal from the IR detector. This ensures that the IR module is properly
installed and operating.

Manual IR Oi Test Active. This bit turns on while a manual Oi test
is in progress.

From the Point Configuration screen, highlight the ARM, then click on
Display Point or select Point from the View menu. The ARM Point Display
screen will be displayed. See Figure VII–13.

STATUS INDICATORS

Low Voltage. This indicator turns on when the input power voltage to
the ARM is below 17.5 volts.

Com 1 / Com 2. One of these bits is set when the ARM’s fault isola-
tion circuitry has detected and isolated a LON wiring fault.
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NV Input Fault. The NV (Network Variable) Input Fault indicates that
the ARM is not receiving periodic messages from the logic controller.
The most frequent cause of this problem is improper logic controller con-
figuration. Logic controllers must be configured to send messages to out-
put devices like ARMs and SAMs. This is done on the Network Variables
configuration screen, which is accessed by pressing the Network Setup
button on the logic controller configuration screen. Select the ARM in
question and press the Enable button, then download the new configu-
ration data to the logic controller. The NV Input Fault bit is automatical-
ly cleared when the ARM begins receiving the messages.

Unable to Configure. This bit is set by the gateway when it was
unable to successfully transfer configuration information to the ARM.

Inhibit Active. This bit is set to indicate that the gateway relays and
display are inhibited from responding to changes in the status of the
ARM. The Inhibit Active status bit is controlled by the “Inhibit” button.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the ARM. The bit is cleared when a new status update is received.

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.
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Output Active. This indicator turns on while the output circuit is
active.

Output Open. This indicator turns on when the output circuit is not
properly terminated. A wire could be open or the device being moni-
tored could be defective.

Output Isolated. This bit is set when the output circuit has been
instructed to enter the Isolate mode. In this condition, the ARM output cir-
cuit is shorted to ensure that no voltage is present on the output. This
mode is utilized when maintenance is performed on the release circuit. 

Auto Config Fault. This bit indicates that the gateway was unable to
successfully download configuration information.

Low Aux Voltage. This indicator turns on when the auxiliary input
voltage is below the specified limit. This fault is self-clearing when the
correct auxiliary power input voltage is applied.

RELEASE MODE

This field identifies the output mode that is currently configured.

RELEASE TIME

When timed mode is used, this field shows how long the release will
continue.

ALARM ADDRESS

This area shows the address of the logic controller that is configured for
communication with this ARM. All trouble status information will be sent
to the address listed here. The address can be changed on the ARM
configuration screen. It is important to ensure that the logic controller is
configured to communicate with this device.

ALARM HISTORY

The ARM stores the time and date of the last eight activations. This infor-
mation is displayed by pressing the Fetch Logs button.

UPDATE RATE

This field shows in milliseconds how often the ARM will report its status
to the gateway. The update rate is programmable from 1 to 10 seconds
on the ARM configuration screen.
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FETCH LOGS BUTTON

This button will retrieve the alarm logs.

From the Point Configuration screen, highlight the SAM, then click on
Display Point or select Point from the View menu. The SAM Point Display
screen will be displayed. See Figure VII–14.

STATUS INDICATORS

Low Voltage. This indicator turns on when the input power voltage to
the SAM is below 17.5 volts.

Com 1 / Com 2. One of these bits is set when the SAM’s fault isola-
tion circuitry has detected and isolated a LON wiring fault.

NV Input Fault. The NV (Network Variable) Input Fault indicates that
the SAM is not receiving periodic messages from the logic controller.
The most likely cause of this problem is incorrect logic controller con-
figuration. Logic controllers must be configured to send messages to out-
put devices like SAMs. This is done on the Network Variables
Configuration screen, which is accessed by pressing the Network Setup
button on the Logic Controller Configuration screen. Select the SAM in
question and press the Enable button, then download the new configu-
ration to the logic controller. The NV Input Fault bit is automatically
cleared when messages are received.
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Unable to Configure. This bit is set by the gateway when it was
unable to successfully transfer configuration information to the SAM.

Inhibit Active. This bit turns on to indicate that the gateway relays
and display are inhibited from responding to changes in the status of
the SAM. The inhibit active status bit is controlled by the “Inhibit” but-
ton.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the SAM. The bit is cleared when a new status update is received.

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

Output 1 and 2 Active. These indicators turn on while the output cir-
cuit is active.

Output 1 and 2 Shorted. These indicators turn on while the output
circuit is shorted.

Output 1 and 2 Open. The open indicators turn on when the output
circuit is not properly terminated. A wire could be open or the device
being monitored could be defective.

Low Aux Voltage. This indicator turns on when the auxiliary input
voltage is below the specified limit. This fault is self-clearing when the
correct auxiliary power input voltage is applied.

Auto Config Fault. This bit is set when the gateway was unable to
successfully download configuration information.

UPDATE RATE

This field shows in milliseconds how often the SAM will report its status
to the gateway. The update rate is programmable from 1 to 10 seconds
on the SAM configuration screen.

ALARM ADDRESS

This area shows the address of the logic controller that is configured for
communication with this SAM. All trouble status data will be sent to the
address listed here. The address can be changed on the SAM configu-
ration screen. It is important to ensure that the logic controller is config-
ured to communicate with this device.
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ALARM HISTORY

The SAM stores the time and date of the last eight activations. This infor-
mation is displayed by pressing the Fetch Logs button. Circuit 1 or 2 will
be displayed to identify the output that was activated.

FETCH LOGS BUTTON

This button will retrieve the alarm logs.

From the Point Configuration screen, highlight the Power Supply
Monitor, then click on Display Point or select Point from the View menu.
The Power Supply Monitor Point Display screen will be displayed. See
Figure VII–15.

STATUS INDICATORS

Bar Graph Display. The bar graph display shows the battery current
in amperes. A positive value indicates battery charging current, while a
negative value indicates battery discharge current. In normal operation
the current should be near zero.

Low Voltage. This indicator turns on when the input voltage to the
power supply monitor (PSM) is below 17.5 volts.
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Com 1 / Com 2. One of these indicators turns on when the fault iso-
lation circuitry in the power supply monitor has detected and isolated a
LON wiring fault.

AC Failed. This indicator turns on when the AC voltage drops below
the fault threshold for 20 seconds. The status will automatically clear
when the voltage is above the threshold for 20 seconds. The default
fault threshold is 85% below the nominal voltage, however,  this can be
changed on the PSM configuration screen. Pressing the AC Voltage but-
ton will display the actual voltage level.

Unable to Configure. This bit is set by the gateway when it was
unable to successfully transfer configuration information to the PSM.

Inhibit Active. This indicator turns on when the gateway relays and
display are inhibited from responding to changes in the status of the
PSM. The inhibit active status bit is controlled by the “Inhibit” button.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the PSM. The bit is cleared when a new status update is received.

Power Supply Fault. This indicator turns on when the AC power is
good, but power is being drawn from the batteries. This fault suggests
a problem with the DC power supply or power wiring. 

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

Ground Fault + / -. This bit is set when a ground fault is detected on
the positive or negative side of the power supply. To locate the problem,
remove the power wires from one section of the system at a time and
look for the fault to clear. The status is self-clearing after the problem has
been corrected.

Battery Fault. This indicator turns on when the back-up battery is dis-
connected from the power supply. This is detected by monitoring the cur-
rent flow between the DC power supply and the battery.

Auto Configuration Fault. This bit indicates that the gateway was
unable to successfully download configuration information.
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UPDATE RATE

This field shows in milliseconds how often the PSM will report its status
to the gateway. The update rate is programmable from 1 to 10 seconds
on the PSM configuration screen.

ALARM ADDRESS

This area shows the logic controller addresses that are configured for
communication with this PSM. All trouble status data will be sent to the
addresses listed here. The addresses can be changed on the PSM con-
figuration screen. It is important to ensure that the logic controller is con-
figured to communicate with this device.

AC VOLTAGE BUTTON

Pressing this button will display the AC voltage level measured at the
power supply monitor.
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Point display screens provide detailed status information for each con-
figured point on the network. Information provided on the point display
screens includes: 

• current analog value (displayed as bar graph and in engineering
units)

• alarm setpoint levels
• communication status
• sensor status
• relay status
• calibration status and history
• alarm status and history.

All point display screens share the following common fields.

Point Name is displayed in the upper left hand corner of the screen.

LON Name and Point Number are displayed in the upper right
hand corner of the screen.

Goto Point, Next Point and Previous Point buttons allow the
operator to navigate from one point to another.

Inhibit button toggles the status of the inhibit bit. When a point is inhib-
ited, the gateway relays and display are inhibited from responding to
changes in the status of this point.

Close button closes this screen and returns to the previously displayed
screen.

Status Indicators are normally black and turn red when active. In a
properly operating system with no faults or alarms occurring, all indi-
cators are off with the exception of the LON Master indicator on the
Gateway Point Display screen.

From the Point Configuration screen, highlight the gateway, then click
on Display Point or select Point from the View menu. The Gateway Point
Display screen will be displayed. See Figure VIII–1.
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INDICATORS

Upper Xcever Fault and Lower Xcever Fault. These bits indi-
cate that the self-diagnostic tests have detected a malfunction in one of
the LON communication transceivers. Reset the gateway by cycling
power. If the fault continues, replace the gateway.

Gateway Fault. This bit is set when the self-diagnostic test has detect-
ed an internal problem with the gateway. Reset the gateway by cycling
power. If the fault continues, replace the gateway.

LON Relay Override. This bit indicates that the user has overridden
the normal function of the gateway’s LON relay. The LON relay is used
to connect the ends of the network in the event of a LON fault. While
troubleshooting, it is helpful to override the automatic function of this
relay. However, it is critical to return the relay to the automatic mode
after troubleshooting is completed.

Invalid Configuration. This bit indicates that the gateway has not
been configured or that the configuration does not match the DIP switch
settings.

Unable to Configure. The main gateway was unable to successfully
transfer configuration data to an auxiliary gateway.

Not Communicating. This bit is set when any configured gateways
fail to report on schedule.
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Inhibit Active. This bit indicates that the gateway relays and display
are inhibited from responding to changes in the gateway’s status word.
The status is controlled by the “Inhibit” button.

LON Master. This bit indicates which gateway is currently sending the
time and date heartbeat messages. This bit is normally on for main gate-
ways and off for auxiliary gateways. If auxiliary gateways or logic con-
trollers do not hear the heartbeat messages from the main gateway, they
will send the heartbeat messages and set this bit.

LON Fault. This bit is set when the time and date message sent out
from one side of the gateway is not being received by the other port,
indicating the presence of a short or open on the network. This bit is set
any time that a short or open condition occurs on the network.

Slave PLC. This bit is set to indicate that an attached PLC is respond-
ing.

Net Test Fault. The main gateway periodically sends the time and
date heartbeat messages in the opposite direction to test for failed net-
work extenders. This bit is set to indicate a test failure. The bit will
remain set until the system passes the test. The test is conducted once
every 20 minutes.

Fault Relay Active. This bit is set when the gateway fault relay is
active. The relay is triggered when an open is detected on the LON or
a gateway fault is detected.

BUTTONS

The Reset Relay buttons are used to reset the gateway relays when
set for latching operation.

From the Point Configuration screen, highlight the communication mod-
ule, then click on Display Point or select Point from the View menu. The
Communication Module Point Display screen will be displayed. See
Figure VIII–2.
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PROCESS VARIABLE DISPLAY

The gas level / process variable is graphically displayed on an analog
bar graph. The scaling and engineering units will change depending on
the type of gas and configuration settings.

STATUS INDICATORS

Low Voltage. This bit is set when the input power voltage to the com-
munication module is below 17.5 volts. The actual voltage can be read
from the “Network” screen. The typical cause of this fault is under-sized
wire.

Com 1 and Com 2. One of these bits is set when the communication
module’s fault isolation circuitry has detected and isolated a wiring
fault.

Unable to Configure. This bit is set by the gateway when it is unable
to successfully transfer configuration information to the communication
module.

Power up. This bit is set during the power-up time delay.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the communication module. The bit is cleared when a new status
update is received.
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Inhibit Active. This bit indicates that the gateway relays and display
are inhibited from responding to changes in the communication mod-
ule’s status. The Inhibit Active status is controlled by the “Inhibit” button.

Sensor Fault. This bit is set when the gas level is below the fault
threshold or the Invalid Configuration bit is set.

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

Digital Input 1/2. This indicator shows the status of the signal con-
nected to the communication module’s digital input.

Output Relay. This bit is set when the communication module’s output
relay is activated.

CALIBRATION INFORMATION

In Calibration. This bit is active during the sensor calibration proce-
dure.

Calibration Fault. This bit is set when a fault is detected during the
calibration procedure.

Calibration History. The communication module stores the baseline
and the last seven calibration records (date, time, high and low cali-
bration values). These records allow the operator to spot trends in sen-
sor sensitivity or potential problems. Clicking in the calibration history
box will bring up a graphic representation of the calibration history.

ALARM INFORMATION

High and Low Alarm. The alarm indicator is on when the gas con-
centration exceeds the alarm setpoint and clears when the level returns
below the setpoint. The current alarm setpoint values are also displayed.
The alarm setpoint values are selected on the point configuration screen.

Alarm History. The communication module stores and displays the
last eight alarms (high and low). The display includes the type of alarm
and the time and date stamp.

UPDATE RATE

This field shows in milliseconds how often the communication module
will report its status to the gateway. The update rate is programmable
from 1 to 10 seconds on the communication module configuration
screen.
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RESET BUTTON

This button resets the communication module’s output relay.

FETCH LOGS BUTTON

This button will retrieve the alarm logs.

From the Point Configuration screen, highlight the relay node, then click
on Display Point or select Point from the View menu. The Relay Node
Point Display screen will be displayed. See Figure VIII–3.

STATUS INDICATORS

Com 1 and Com 2. One of these bits is set when the relay node’s
fault isolation circuitry has detected and isolated a wiring fault.

Fault. This bit is set when the internal fault detection circuitry has indi-
cated a hardware fault.

Digital Input 1/2. These indicators show the status of the signals con-
nected to the relay node’s two digital inputs.
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Low Voltage. This bit is set when the input power voltage to the relay
node is below 17.5 volts. The actual voltage can be read from the
“Network” screen.

Unable to Configure. This bit is set by the gateway when it is unable
to successfully transfer configuration information to the relay node.

Output Relay Active. This bit is set when the relay node’s output
relay is activated.

Inhibit. This bit indicates that the gateway relays and display are inhib-
ited from responding to changes in the relay node’s status. The Inhibit
status is controlled by the “Inhibit” button.

Not Communicating. This bit is set by the gateway when its diag-
nostic routine indicates that it has not received periodic status messages
from the relay node. The bit is cleared when a new status update is
received.

Invalid Configuration. This bit indicates that configuration informa-
tion is invalid and is set on a new unit, when the address is changed,
or when invalid data is transferred. A valid configuration must be down-
loaded to clear the bit.

Force On. This bit indicates that the relay is in a “force on” condition,
causing it to be in its active state, regardless of voting or other pro-
grammed responses.

Force Off. This bit indicates that the relay is in a “force off” condition,
causing it to be in its inactive state, regardless of voting or other pro-
grammed responses.

ALARM HISTORY

The relay node stores and displays the last eight alarms (high and low).
The display includes the type of alarm and the time and date stamp.

BUTTONS

Reset. This button resets the relay node’s output relay.

Fetch Logs. This button will retrieve the alarm logs.
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Force On. This switch puts the relay node’s output relay in a “force on”
condition, causing it to be in its active state, regardless of input condi-
tions.

Force Off. This switch puts the relay node’s output relay in a “force
off” condition, causing it to be in its inactive state, regardless of input
conditions.
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To determine the location of a wiring fault on the network:

From the Point Configuration screen, click on the Overview button to dis-
play the System Overview screen. This screen provides an overview of
the entire system. Each configured node is represented by a square on
the loop, and is identified by its address number. The color or the square
indicates the status condition.

Black = Normal operation
Red = Alarm
Yellow = Fault condition.

Click on the LON Diag. button. The LON Diagnostic screen is dis-
played. See Figure IX-1. 

In the LON diagnostic mode, each node changes color as it reports to
the gateway at the update rate determined at the time of configuration.
This continual change in color indicates that normal LON communica-
tion is occurring. The color of the node indicates which of the gateway’s
two transceivers is receiving the message — green = LON 1, blue =
LON 2, red = no communication. (The three boxes in the lower right
hand corner of the screen are not buttons, but represent the gateway
transceiver color code.)
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Selecting the LON Order button allows the nodes to be dragged to any
position on the screen in order to match the actual position on the LON
(for systems where the devices on the loop are not wired in numerical
order).

Selecting the Point Order button displays the points in numerical order.
(This does not affect changes that were made after selecting LON
Order, as described above.)

Click on the LON Override button. This resets the Gateway’s LON relay
(opening its contacts).

Under normal conditions, the gateway LON relay contacts are open
and information moves over the network as shown in Figure IX–2. 

When a network fault occurs, the relay contacts close and the data trav-
els as shown in Figure IX–3.

9.2 LON TROUBLESHOOTING
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Communication with a
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NOTE
Since the logic controller occupies an address on the LON, the
relay contacts must close during a fault condition to ensure normal
communication until the fault can be repaired. Closing the con-
tacts allows messages from the downstream side of the wiring
fault to pass through the gateway and reach the logic controller.
As a result, messages will continue to be received by both gate-
way transceivers.

By opening the contacts using the LON Override button, each node is
able to report to only one side of the gateway. All nodes on one side of
the fault will be blue and all nodes on the other side will be green, with
the wiring fault located between the last green node and the first blue
node. 

In the event of multiple wiring faults on the LON, as shown in Figure IX-
4, those nodes between the faults are unable to communicate with the
gateway. In this case, all nodes between the faults will be red in color,
while the nodes on one side of the fault will be blue and the nodes on
the other side will be green.

When troubleshooting is complete, click on the LON Override button to
return the gateway relay to normal operation.

IMPORTANT
Incorrect network communication can occur if the gateway relay
is inadvertently left in the LON Override position.

Click on the Network button to return to the Point Configuration screen.
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From the Point Configuration screen, highlight the logic controller, then
click on the Display Point button. The Logic Controller Point Display
screen will be displayed. Click on the Diagnostics button. The Logic
Controller Diagnostics screen will be displayed. A tabbed notebook is
displayed at the top of the screen.

LC NV STATUS WORDS

Click on the LC NV Status Words tab to display the Logic Controller
Network Variable Status Words screen. See Figure X–1. This display
shows the raw alarm message data entering and leaving the logic con-
troller. The alarm messages consist of 16 bit words with some bits pre-
defined, while others have special meaning depending on the device
type.

CARDS DETECTED

Click on the Cards Detected tab to display the LIOU Cards Detected
screen. See Figure X–2. During configuration a list of LIOU boards is
generated. On power-up the logic controller polls all available board
addresses, establishing a list of “detected boards”. The logic controller
then compares the list of detected boards with the list of configured
boards. If extra boards are found, the IO Board Count fault bit is set. If
any boards are missing, the IO Not Communicating fault bit is set.
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This screen displays the type and address of each detected board. A
command can be sent to the logic controller to poll for all available
boards by pressing the “Detect Cards” button. This command takes
approximately 20 seconds and the logic controller must be in program
mode. This list can also aid in finding wrong address settings.

LOCAL HARDWARE

Click on the Local Hardware tab to display the Logic Controller Scan
Time screen. See Figure X–3. The logic controller scan times are used to
measure the logic controller’s performance. The numbers represent the
time required to update the input image table, process up to 32 pages
of custom logic, and update all the output field devices. Typical times
range from 300 to 900 milliseconds, however, the times can increase
depending on the number and type of field devices and the amount of
logic being performed.

10.2 LOGIC CONTROLLER DIAGNOSTICS

FIGURE X-2

LIOU Cards Detected by the
Logic Controller
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EagleVision-NT offers password protection to keep unauthorized per-
sonnel from modifying system configuration. When the entire system has
been configured and correct operation has been verified, security can
be set up using the following procedure.

1. From the Point Configuration screen (Figure V–1) select Overview.
The system Diagnostic screen is displayed (Figure IX–1).

2. Under the File menu select Security. The Login screen will be dis-
played. See Figure XI–1.

NOTE
Passwords are case sensitive.

3. Enter “Administrator” in the User ID box and “Admin” in the
Password box. (This default password allows entry to the highest
level of security.) The Security screen is displayed. See Figure XI–2.
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EagleVision-NT provides four levels of security protection, with each
level allowing access to different EagleVision-NT features. Refer to Table
XI–1.

1. Enter a name and password for each user:  
With the Security screen displayed, click on the Add button. Enter a
user’s name in the User ID box and a password in the Password
box. Enter the same password in the Confirm Password box. The
“Password” and “Confirm Password” entries must match exactly to
be accepted. Click on the Accept button. The name of each user is
added to the user list in the upper right hand portion of the Security
screen. Repeat the process for each user.

2. Assign an access level for each user:
Select the user’s name from the list in the upper right hand portion
of the screen, then select the appropriate access level in the box at
the lower left hand part of the screen. Click on the Accept button.
Repeat the process for each user.

3. Activate security.  
Click on the Force Passwords check box. The “Force Passwords”
check box functions as an “On/Off” switch for the Security feature.
When “Force Passwords” is checked, the security feature is opera-
tional. When it is not checked, EagleVision-NT will not request a
password to gain entry.

4. When all entries have been made, click on OK. The System
Diagnostic screen is displayed.

11.2 SECURITY

Point Point LON Download Logic Upload Quit
Display Configure Override

Administrator X X X X X X X
Fire Engineer X X X X X X X
Engineer X X X X X
Operator X

TABLE XI-1

EagleVision-NT Security

ESTABLISHING A USER LIST



Any operator can change his/her password by selecting “Password”
from the File menu on the Overview screen. The Change Password
screen is displayed. See Figure XI–3. Enter the user’s name in the “User
ID” box, the old password in the “Password” box, and the new pass-
word in the “New Password” and “Confirm Password” boxes (these two
entries must match exactly).
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